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  Operating Level Agreement (OLA) Template 
 

About this template 
This template provides a consistent format for all Operating Level Agreements (OLAs) between internal units of ITS. It addresses 
responsibilities and procedures for these internal units, whose purpose is to provide IT services and support to the UCSC 
community.  The objective of the OLA is to present a clear, concise and measurable description of the service provided.  
 
The OLA template is maintained by IT Services. If you have suggested changes to the template, please contact IT Services. 

 

How to use this template 
• Save this template under a new name before making any changes. 

 

To save the template under a new name 
 

1 On the File menu, click Save As. The Save As window opens. 
2 In the Save in box, select the location for the new file. 
3 Enter a new name in the File name box. 
4 Click Save. 

  

• Use only the sections of this document relevant to the OLA being addressed. Delete any non-relevant sections. 
 

• Delete any blue text during final revision. Blue text indicates instructional information.   
 

• Replace pink text with appropriate relevant text. Pink text also indicates a cross-reference you may need to modify or 
delete. Reformat pink text to black. 

 

To delete the template watermark 
 

1 On the View menu, click Header and Footer. The Header and Footer toolbar opens. 
2 In the document, select the template watermark. 
3 Press DELETE. 
4 Click Close in the Header and Footer toolbar. 

 

• Change the header to reflect the appropriate Service. 
 

To change the header 
 

1 On the View menu, click Header and Footer. The Header and Footer toolbar opens. 
2 Select and delete the appropriate items from the header. 
3 In the Header and Footer toolbar, click Close. 

 

• Generate a new table of contents after final edits are made. 
 

To generate a new table of contents 
 

1 Right-click in the Contents. A context-sensitive menu appears. 
2 Select Update Field. The Update Table of Contents window opens. 
3 Select Update entire table. 
4 Click OK. The Contents is updated. 

 

• Select this instructional page and press DELETE.
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1 General Overview 

This document represents an Operational Level Agreement (“OLA”) between the service providers to 

document the working relationships and response times for supporting [service name from service catalog or 

elsewhere]. This OLA shall remain valid until revised or terminated.  

 

The purpose of this Operational Level Agreement (“OLA” or “Agreement”) is to ensure that the proper 

elements and commitments are in place to provide consistent service support and delivery by the Service 

Provider(s). 

 

The goal of this Agreement is to obtain mutual agreement for service provision between ITS units. 

 

The objectives of this Agreement are to: 

 

• Provide clear reference to service ownership, accountability, roles and/or responsibilities. 

• Match perceptions of expected service provision with actual service support & delivery. 

2 Service and Charges 

2.1 Scope 

Place the technical description of the service here. 

 

2.2 Charges (if applicable) 
 

2.3 Service Dependencies and Underpinning Contracts 
These services are necessary elements of the service_name service to function as documented. Each of 

these services has an OLA. (If an OLA exists, a link will be provided. If an OLA does not exist, the units 

listed are your primary units for contacting). Additionally, describe the dependency as best as possible. 

� Network (NTS) – Network available for service_name during specified hours of operation 

� Backups (Core Tech) 

� Data Centre Hosting (Core Tech) 

� Vendor support (Name, if any) 

� Add other dependent services or underpinning contracts 

 

2.4 Assumptions 
The bullets below are generic. Add assumptions specific to the service. 

• Service_name is clearly documented in the service catalog. 

• This document represents the current configuration to support the Service_name service. Changes to 

the service_name service are handled as projects, which is outside the scope of this document. 

• Funding for major upgrades/updates will be negotiated on a service-by-service basis. 

3 Parties Responsible 

List all relevant contact persons. 

The following Service Provider(s) are associated with this OLA: 

 

Service Provider Title / Role Contact Information* 

[Service provider 1] [Title / Role] [Contact Information] 

[Service provider 2] [Title / Role] [Contact Information] 

 
*NOTE: Availability is defined in Section 4, Hours of Coverage, Response Time & Escalations. 

Phone numbers are not to be used during off-working hours unless specified in this section. 
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4 Service Provider Requirements (Roles and Responsibilities) 

Responsibilities and/or requirements for all service providers in support of this Agreement include:  

• Meet response times associated with the priority assigned to incidents and service requests. 

• Train required staff on appropriate service support tools (cite examples for this service) 

• Use the Outage Notification Process to notify Customers for all scheduled maintenance via the 

Maintenance Calendar, Service Catalog web page and/or a communication to campus via the 

Communication Specialist. 

• Participate in all service support activities including incident, problem, change, release and 

configuration management. 

• Meet SLA metrics as stated in the service_name SLA located Service SLA_link 

• Additional requirements identified during technical or functional requirements gathering, e.g., as part 

of ITS’ Design Review Board (DRB) process (http://its.ucsc.edu/ea/drb/ and https://collab.ucsc.edu/its-

group-spaces/design-review-board/templates-design-materials). 

 

Service Provider 1 agrees to provide: 

 

Service Provider 2 agrees to provide: 

 

Applications and Project Management (APM) agrees to provide  

• Non-Network Server Hardware support and configuration, and act as a liaison to the Server 

Hardware Vendor(s) for problem reports and incident handling, EXCEPT for the Servers which are 

hosted in the VM infrastructure. 

• Non-Network Server Operating System support and configuration, and act as a liaison to the Server 

Operating System Vendor(s) for problem reports and incident handling. 

• Non-Network Server Application Software support and configuration, and act as a liaison to the 

Server Application Software Vendor(s) for problem reports and incident handling. 

• Provide expertise to handle user support cases that the Support Centre needs to escalate to 

Productivity Tools. 

• Act as liaison to Purchasing to set up support contacts for hardware and software. 

 

Support Centre agrees to provide  

• Verification of client eligibility 

• Diagnosis and investigation of problems, incidents and requests for information regarding the Mail 

included using and configuring filters (rules), spam scanning, client software and the webmail client 

• Writing end-user documentation, technical descriptions, work-arounds, and support documentation for 

its technicians  

• Client software testing and recommendations 

• Account provisioning and testing 

• Coordinates major incident handling. 

 

Data Centre Operations agrees to provide off-hours support that includes 

• Maintain and enforce secure physical access to Data Centre facilities 

• Monitoring of hardware, software, services and environments 

• Escalate detected problems/events (via monitoring or physical inspection) to the appropriate parties 

per procedures established within ITS and/or procedures established with stakeholders 

• Serve as initiation/coordination point for major incidents 

• Perform and manage system backups 

• Perform and manage manual processing or operational tasks for stakeholders 

 

IT Service Manager is responsible and accountable for the full lifecycle and the performance of Mail 

including 

• Design and develop robust IT services to meet client requirements 
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• Review, analyze and make recommendations on improvement opportunities in each lifecycle phase 

• Develop and maintain the service catalog 

• Monitor service performance and providing regular reports 

• Retire services 

5 Incident and Service Request Processing 

This section validates the supported processes to manage service delivery. Exceptions are also documented. 
 

5.1 Service Requests 
Work Requests (if applicable)/Standard Service Requests 
Work requests as defined by Media Services or Telco.  

 

Describe service requests related to this service. Examples of this could be application upgrades, OS 

patches, architecture changes, consultation about use of the service, setting up mail lists, etc. 

 

Non-standard Service Requests/Ad-hoc Work Requests 
Describe one-time or limited-time work not documented in the service catalog. Examples of this include set 

up of a WAP in a classroom for a quarter, de-install there after. Or restore email for the Chancellor but not 

for a student. The point of this is to inform ITS staff of what kinds of one-offs service providers can provide in 

order to help set client expectations. 

 

Describe how each non-standard service request or ad-hoc work request is to be processed so that it gets 

evaluated by the most appropriate staff member or service team. 

 

5.2 Service Change Request 
Service Change Requests can be sent to the Service Service Manager. The service team will review the 

request to understand the need and shepherd it through the appropriate channel. 

 

5.3 Incident Management 
 

Normal Incident Processing 

As this text becomes standard, please refer to the escalation procedures located in the Internal Service 

Catalog for greater detail on how incidents and service requests are processed and escalated. 

Service Providers supporting this service will prioritize incoming service incidents as low, medium or high 

priority unless the service incident fits one or more of the criteria listed below. 

 

Service Providers supporting this service will prioritize incoming incident requests as an urgent incident if it 

meets any one of the following criteria: 

 

� Significant number of people affected. 

o Organizational structure is a multiplier for number of people affected. Ie Significant impact on 

principal officer's ability to conduct university business 

� Percentage of total tasks that can no longer be performed by individuals. 

� Academic and Administrative Calendar deadlines. 

� Significant impact on the delivery of instruction. 

� Significant or lasting impact on student academic performance. 

� Significant risk to law, rule, or policy compliance. 

 

When an IT Request ticket is opened for a customer 

• The Support Centre will respond to the customer and process all new IT Request tickets within 8 

business hours. 

• For low priority incidents, Service Providers agree to status the Support Centre by updating the 

technote in the ticket every negotiate/add the time interval. 
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• For medium priority incidents, Service Providers agree to status the Support Centre by updating the 

technote in the ticket every negotiate/add the time interval. 

• For high priority incidents, Service Providers agree to status the Support Centre by updating the 

technote in the ticket every 8 hours until resolved. 

• For urgent priority incidents, Service Providers agree to status the Support Centre by updating the 

technote in the ticket every 2 hours until resolved. 

 

Service Provider Hours of Operation 

Service provider 1 Add HoO 

Service provider 2 Add HoO 

 

Major Incident Handling 
Evaluate if your service has any MI situations. If so, complete this section. Otherwise state as such and 

delete the standard text. 

Under these circumstances, begin Major Incident Handling: 

� Circumstance 1 

� Circumstance 2 

 

MIH Team Contact Information Back up Contact 
Information 

Tech Lead  Add name and phone  

Major Incident Coordinator – Core 
Hours 

  

Major Incident Coordinator – After 
Hours 

  

Subject Matter Expert Add name and phone  

NOC Contact   
 

Additional information regarding the roles, responsibilities, and process flows of the Major Incident Handling 
process is located <<here>>. 

 

5.4 Problem Management 
This section is a placeholder for the problem management process. If your service has a way of dealing 

with problems (root cause as opposed to incidents), note it here. 

 

5.5 Service Maintenance/Change Management 
All services and/or related components require regularly scheduled maintenance (“Maintenance 

Window”) in order to meet established service levels. These activities will render systems and/or 

applications unavailable for normal user interaction for the following locations and timeframes: fill in 

times 

 

 

Time Sunday Monday Tuesday Wednesday Thursday Friday Saturday 

Begin        

End        

  

Service Providers for this service follow the Change Notification Process. This is documented http://name.  

 

Optional:  

Service Providers for this service adhere to a “no change” rule during the following academic calendar: 

• The week prior to and of finals 
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• The first week of the quarter 

• Cite other no change examples this service adheres to 

 

Changes that the Change Manager and/or Change Advisory Board and the service_name Service Team have 

approved based on frequency and risk are called pre-approved changes. Pre-approved changes decided upon 

for service_name are: Link to internal service catalog page 

 

5.6 Service Exceptions 
Any deviations from current policies, processes and standards are noted by the following Service 

Exceptions: (Insert special exceptions related to coverage times and dates; typically the first item is the 

only item in the list) 

 

Exception  Parameters Coverage 

University Holidays N/A No coverage 

Fiscal Year Close Last business day in 

May 

Additional coverage, 8:00 a.m. to 5:00 p.m. U.S. 

Eastern time 

 

6 Reporting 

This Agreement is valid from date. The Agreement should be reviewed at a minimum once per fiscal year; 

however, in lieu of a review during any period specified, the current Agreement will remain in effect.  

 

IT Services is responsible for facilitating regular reviews of this document. Contents of this document may be 

amended as required, provided mutual agreement is obtained from the primary stakeholders and communicated 

to all affected parties. IT Services will incorporate all subsequent revisions and obtain mutual agreements / 

approvals as required.  

 

Metrics monitored internally for this service are listed through out Section 5. Reporting on these metrics will 

take place (daily, monthly, quarterly) and made accessible on the internal service web page. 

 

This Agreement will be posted to the following location and will be made accessible to all stakeholders: 

 

Document Location: Internal Service Catalog – Service_name service page 

 


